Using IntelliJ to Download and Run lab_1

These instructions are for IntelliJ. If you are using Eclipse, similar instructions on running HJlib programs can be found at http://www.cse.wustl.
edu/~cosgroved/courses/cse231/f16/javaagent/.

Instructions

1. Prepare to checkout the lab_1 project from subversion

8006 VCS Operations Popup...
I3 hi-lib-git ) Show Changes View
7 Project -| O = | B - '§* Commit Changes...
a2 ves |
v [2hj-lib-git Jjava-lib] n-lib—gi ‘s Update P@Je:t...
» [.idea Integrate Project...
» [.settings Refresh File Status
» [Casrc Git
» Cltarget
[ tools Create Patch...
@ .classpath Apply Patch...
4 .gitignore Shelve Changes...
;ﬁ:;::[m, ava-lib.iml Checkout from Version Control GitHub
] Makefile ’ ’ Import into Version Control Vs

Browse VCS Repository Git
Mercurial
Subversion

M pom.xml
> [l External Libraries

2. Use the "+" button to add the repository: https://svn.rice.edu/r/comp322/turnin/S15/NETID/lab_1/

Repositories: + [» — [F 95 =

L4 https: / fsvn.rice.edu/r/comp322 fturnin/S15 fsmil/lab_1

3. Confirm the directory where the directory where the project will be downloaded to.


http://www.cse.wustl.edu/~cosgroved/courses/cse231/f16/javaagent/
http://www.cse.wustl.edu/~cosgroved/courses/cse231/f16/javaagent/

Checkout:  https://svn.rice.edu/r/comp322fturnin/S15/smil/lab_1

Ll Ele ] B /Users fshamsimam /projects/lab_1 |I|
fUsers shamsimam/projects/lab_1/lab_1
fUsers/shamsimam/projects/lab_1/rfcomp322 /turnin/S15/smil...

Update/Switch to revision: () HEAD () Specified =
Depth: infinity :

™ Include externals locations

4. Confirm the subversion version to use for the directory format.

Working Copy upgrade strategy:
() Upgrade automatically (use Subversion 1.6)

() Upgrade automatically (use Subversion 1.7)
(*) Upgrade automatically (use Subversion 1.8)

([Concel ]

5. After the project is downloaded successfully, confirm to open the project.

habanero-java-lib - [~/projects/hj-lib-git]

Checkout From Version Control

. You have checked cut an IDEA project:
fUsers/shamsimam/projects/lab_1
Would you like to open it?

6. Import as a Maven project. Right-click pom.xml, and select "Add as Maven Project". This option is towards the bottom of the options list. Once
you have done that, again right-click on the same pom.xml le and you should now see a "Maven" option towards the bottom of the list. Click on
Maven > Reimport to be sure IntelliJ has pulled in the JARs for this project. Finally, go to File > Project Structure and in the pop up select
"Modules" from the left menu. You should see three JARs listed in the central pane: hjlib-cooperative:0.1.8, asm-all:5.0.3, and junit:3.8.2. Check
the checkboxes next to each, hit "Apply" at the bottom right of the window, and close the window by clicking "OK".
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7. Check the appropriate JDK is selected. Navigate to File > Project Structure and verify that in the "Project" pane you have \1.8" selected as the
\Project SDK.
8. Initial directory layout of the project.

b_1 [labl] (~/projects/lab_L)

» [C.idea
> [Clsrc
.gitignore

[=] README
» [l External Libraries

9. Click on "NO" when a popup shows up asking you whether you want to add an *.iml file to subversion.

*/ - - B - o -
public static void main(final String[] args) {

launci

® Do you want to schedule the following file for addition to Subversion?
[Users/shamsimam/projects/lab_1/labl.iml

2 of H

[ | Remember, don't ask again

15

10. Open the HelloWorldError.java file by double clicking on it. Fix the error by editing the "ss" variable.
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[5] HelloWorldError - [lab1] - labl - [~/proje:

[alab_1 ) [ sre,s [ main > [ Java ) [ edu b [ rige > 51 comn322, > < HelloWorldError, »
a2 38 nain, A, sg4, [ rice > =] compies,

[ Project x

FEE A

¥ Eilab, 1 [lab1] (~/projects/lab_1)
» [.idea
v Csre
v Cimain
v [Cjava
v [Eledurice;comp322.
<" HellowerldErmer
&u ReciprocalArraySum
¥ Eltest
v [ljava
¥ [Z1edu.rice.comp322
2% LablTest

v

Cotarget

4 .gitignore
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m pom.xmil

[EI README
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*
*

< HelloworldError *

Lic static tinal String s = “"HelloWorld™;

<pemain.</p>

* @param args an array of {@link String} objects.
*

public static void main(final String[] args) {

LaunchHabaneroApp(() -> {

finish(() -> {

/7 HjRunnable is a functional interface.

/7 It has one unimplemented method: void run()

/7 The statement below is using lambda expression

/7 Note we are avoiding the verbose syntax to cre

final HjSuspendable aRunnable = () -> {
System.out.println("First: " + fs);

b

/7 We pass async an instance of HjRunnable to run

asyncCaRunnable) ;

/7 Instead we can also directly inline the lambda
async(Q) -> {
/7 TODO: Fix the error by changing 'ss’ to 's
System. out.println("Second: " + 5);
b
s

;

Messages Make

& Ml I

symbol:

0+ XHNE7T
€ K

@ Information: Using javac 1.8.0_05 to compile java sources
@ Information: java: Errors occurred while compiling module 'lab1'
@ Information: Module “lab1" was fully rebuilt due to project configuration/dependencies changes
@ Information: 1/11/15, 8:15 PM - Compilation completed with 1 error and O warnings in 11 sec
w [i] /usersfshamsimam/projects/lab_1/src/main/java/edu/rice/comp322/HelloWorldError.java
Error:(36, 52) java: cannot find symbol
variable ss
location: class edu.rice.comp322.HelloWorldError

11. Open the "Changes View" so that you can see your edits.

@ Intelli) IDEA File Edit Navigate Code Analyze Refactor Build Run Tools VCS Windoy

800 : . B Tool Windows > Messages w0 [5] Hellow
Fatab 1) Cisre ) Cirest) E1a ) B o jick Definition o  J1Project %1
5 Project d | Show Siblings ¥r Favorites 82
v Cilab_l flabl] (~/projects/lab_1) Quick Documentation ~] P Run %f 322;
» O.idea I3 Show Bytecode = Debug 35
v [Csrc [Z» Jump to Source F4 2T0DO %6
v [main T Structure 87
v [java Recent Files ®E 2 Changes %9
v [edu.rice.comp322 Recently Changed Files ?SEE # Ant Bwlq P HelloWorldErro
2 % Helloworldern ~ Recent Changes x4C 2l Application Servers
» " | E Commander
. & B RediprocalArt o mnare File with Editor ; Designer ttp://shams.web.,
v tm_ Compare with Clipboard m Eveﬁt Log
v Ojava g ) LdError {
¥ [edu.rice.comp322 Quick Switch Scheme... ~ M Maven Projects
¢ LablTest | b Palette
Toolbar Pal
» Citarget alefte s="HelloWor1d"
4 .gitignore Tool Buttons Terminal X F12 [ =
Il labl.iml v Stat_us B’_ar Ul Designer al String s = "H
M pom.xmi + Navigation Bar Version Control 9 !
[ ReaDME Enter Presentation Mode I ) p—
» i External Libraries Enter Full Screen ~%8F : * cpemain. </p>
*

* @param args an array of {@link
*/




12. The changes view will show you the files you have edited.

41
A2 @
Changes: Repository | Incoming | Subversion Working Copies Information |
¥ Default (1 file)

5]

»  Unversioned Files (4 directories and 13 files)

[
O=

|
o ?

13. Submit your changes to the subversion repository by committing the changed files (right-clicking on the Default or HelloWorldError.java file in the
Changes view).

lapiat r
Changes: Repository | Incoming | Subversion Working Copies Information |
g =¥ Default (1 file)
= D HellowWorldError_iava (~/nroiecrs/lah 1/src/main/iaval/edu/rice/comp322)
L T ls  Commit Changes...
b5 O O Revert... N¥Z
+ M &' Move to Another Changelist F6
i Show Diff D
- [ Jump to Source F4
B=
€ M@ » Delete
& ? Create Patch...
Shelve Changes...
) Refresh ~F5
Local History >
Subversion >

14. Add a commit message and commit the file.

(T3

* 448,08 EommiCiangesy
‘J‘fﬁ LI -E L[F]‘ - Change list: | Default ©  Subversion
v [ Calabl (I file) ["| Auto-update after commit
L& v [ [1/Users/shamsimam/projects/lab_1/src/main/java/edu/rice/comp322 (1 O Keep files locked
* # [il HelloWorldError.java
f Before Commit
"
P || Reformat code
b ["| Rearrange code
™ Optimize imports
["] Perform code analysis
Modified: 1 "] Check TODO (Show All) Configure
. C] Cleanup
Commit Message v )
|| Update copyright
-~ fixed hello world error

Create Patch...




15. Confirm that you see the successfully committed message to ensure that your changes have been submitted to the repository.

38 /7 We pass async an instance of HjRunnable to run asynchronously
39 async(aRunnable);
40
41 /7 Instead we can also directly inline the lambda expression into the ¢
42 &l asvwno(() - {

Changes. m Repository ‘ Incoming | Subversion Working Capies Information

¢ = Default (Nofies)

v = ¥ Unversioned Files (4 directories and 13 files)

E

5@

+ O

- ©

=

& @

1 file committed: — fixed hello world error
Subversion: Committed revision S008.

[ 1 file committed: — fixed hello world error /f Subversion: Committed revision 5008. (moments ago)

16. Attempt to run the HelloWorldError program by right-clicking on it and selecting the run option. This should fail as the javaagent option has not
been set up. To configure the javaagent option we need to know the path to the HJlib jar file. Maven has already automatically downloaded this
jar file for you, we can look up the path in the project.

*/
public static final String s = "HelloWorld";
w ~ Copy Reference N{OHC
* <psmain.</p> [l Paste ¥V
* Paste from History... T8V
Paste Simple {3V
* @param args an array of {@]
y ¥ 4 © Column Selection Mode {+88m *
public static void main{final Find Usages E7
Analyze >
launchHabaneroApp(() -> { Refactor >
finish(() -> { Folding >
/¢ HjRunnable 1s ¢ Go To >
A/ It has one unin gened. AN
/4 The statement & mn inste
/7 Note we are avd  Compile 'HelloWorldError.java' {+88F9 | inner

final HjSuspendabl [ Create 'HelloWorldErro....main()"...

S NG TNl Run 'HelloWorldErro....main()' ~84F10

b # Debug 'HelloWorldErro....main()' ~{+F9
// We pass async ¢ ¥z Run 'HelloWorldErro....main()' with Coverage LY
async{aRunnable);
Local History >
/7 Instead we can Subversion » into the
asyne(() - { Com . .
. pare with Clipboard

s/ TODO: Fix i File Encoding ¥ the ¢

System. out.pri
2 & Create Gist...

i9H © Add to .gitignore file

;

17. Open the Module Settings



® Intelli) IDEA File Edit View Navigate Cc
800
lab_1
[ Project | 3
v Iﬂ.h_l [Iah'l'l.r lim B mtim Al 1%
» [l.dea |  New >
v [sre Add Framework Support...
v LIma e Cut 38X
v O [ Copy ¥C
Copy Path 4 3C
~ Copy Reference N{raec
[l Paste BV
v Cltes
v [ Find Usages XF7
v Find in Path... “~{rF
Replace in Path... ~{R
» [CJtarget Analyze >
.giti
glillg_ T: Refactor >
m pom.x Clean Python Compiled Files
= READN  Add to Favorites >
> HhiExternall  Show Image Thumbnails  Q®T
Reformat Code... NEL
Optimize Imports... NEO
Remove Module [
Make Module 'labl’
Compile Module 'lab1" {+3F9
@i Create 'All Tests'...
P Run 'All Tests' ~{F10
i Debug 'All Tests' ~{F9
¥ Run 'All Tests' with Coverage
Local History >
Subversion >
CJ Synchronize 'lab_1'
Reveal in Finder
Compare Directory with... F£D
Open Module Settings F4
. Move Module to Group >
Messages Make | Mark Directory As >

kp
H

: & Create Gist...
g m Mawven »

Ml |y

18. Next ensure that the Project Language Level is set to 8.



Project Structure.

806
LS Project name:
Project Settings [labl
Modul Project SDK:
odules This SDK is default for all project modules.
Libraries A module specific SDK can be configured for each of the modules as required
Facets [ E2 1.8 (java version "1.8.0_05") 2 [ New.. | [ Edit |
Artifacts Project language level:
Platform Settings This language level is default for all project modules.
SDKs A module specific language level can be configured for each of the modules as required
Global Libraries | 8 - Lambdas, type annotations etc. o
Problems Project compiler output:
This path is used to store all project compilation results.
A directory corresponding to each module is ereated under this path.
This directory contains two subdirectories: Production and Test for production code and test sources, respectively.
A module specific compiler output path can be configured for each of the modules as required
[JUsers, ts/lab_1/classes | =]
@ | Cancel | |

19. Click on the Libraries option to reveal the path for the hjlib jar file. On my machine it is located at / User s/ shansi mant . n2/ r eposi t ory/ edu
/ricelhjlib-cooperative/0.1.4- SNAPSHOT/ hj | i b- cooper ati ve-0. 1. 4- SNAPSHOT. j ar

800 Project Structure
+ -0
Qo - Name: |MEVEII]Edu.li(Elhj|ib*(DDDEIE(iVE:O.l.Q*SNAPSHQT
N n il Maven: edu.rice:hjlib-coopera
Project Settings 2
N il Maven: junitjunit4.11 m
Project L
HliMaven: org hameresthameres
Modules M Maven: org.onZ,asm - U m /0.1.4-SNAPSHOT  hjlib - cooperative -0. 1.4-SNAPSHOT jar
. s * v [Isources
G /U m2 frepository ice /hjlib-cooperative/0.1.4-SNAPSHOT / hjlib-cooperative -0. 1.4 -SNAPSHOT-sources.jar
Facets v [pJavaDocs
Artifacts Gi/us m; P Y,  /hjlib-coop /0.1.4-SNAPSHOT / hjlib - cooperative - 0. 1.4 -SNAPSHOT - javadoc jar
Platform Settings.
SDKs
Clobal Libraries
Problems
+ [ [ —
cance | (_agmy | [0

20. Now that we know the path, we are ready to edit the run configuration and insert the javaagent option.



21.

22.

23.

[3] HelloWorldError - [lab1] - lab1 - [~/projects/lab_1]

45 [ elovargenor <) b 8 B B E B 5

= | @ HelloworldError x ] B
T public Static final String s = “Hellohorid"; Kl save "HelloWorldError' Configuration

20 HelloWorldError

21 Vand

22 * <p>main.</p>

23 *

24 * @paran args an array of {@link String} objects.

25 v

26 public static void main(final String[] args) {

27

28 o1 launchHabaneroApp(Q) > {

29

e Finish(O) -> {

31 /7 HjRunnable is a functional interface.

32 /7 It has one unimplemented method: void run()

33 /7 The statement below is using lambda expressions to create an instance of HjRunnable

3 // Note we are avoiding the verbose syntax to create anonymous inmer classes with lambdas.

3561 final HjSuspendable aRunnable = O -> {

36 [ System.out.println("First: " + s);

37! b

38 // We pass async an instance of HjRunnable to run asynchronously

39 async(aRunnable) ;

40

a1 // Instead we can also directly inline the lambda expression into the async call.

a2 async(© -> {

a3 // T0DO: Fix the error by changing 'ss' to 's' to gt rid of the compiler error

44 System.out.println("Second: " + 5);

45 b

46 128

a7

48 B;

49 }

se }

Under the VM Options textfield insert - j avaagent : / User s/ shanmsi mani . n2/ reposi tory/ edu/rice/ hjlib-cooperative/0.1.4-
SNAPSHOT/ hj | i b- cooper ati ve-0. 1. 4- SNAPSHOT. j ar text and click OK to save the configuration.

120:0 Lmsmelinm A £~ £

800 Ce
+ -HH%¥ 2 YOl Nme | (] Share [ ] Single instance only
v [ Application

HelloWoridError TSI Code Coverage | Logs

» ¥ Defaults

Main class: edu.rice.comp322.HelloWorldError

Program arguments:

VM options: [ /U imam,/.m2 i ice/hjli ive/0.1.4-SNAPSHOT/hjlib-cooperative-0.1.4-SNAPSHOT.jar

Working directory: /Users /shamsimam/projects /lab_1

Environment variables:

Use classpath of module: | [ labl B

[ Use alternative JRE: 2

(] Enable capturing form snapshots

 Before launch: Make
i Make

+[-[#a]~
(] Show this page

[ cancel | [ Apply | [FOK

®

Now, click on the green play button to run the HelloWorldError.java file wiht the correct VM configurations. The class should be run successfully
and you should see the output as below.

4 l HelloWorldError V] | R "':E "':Es EE.E'
Run 'HelloworldError' (-FLO) |




4L
A7 @ |

Run HelloWarldError

[ + /Library/Java/JavaVirtualMachines/jdk1.8.8_@5. jdk/Contents./Home/bin/
First: HelloWorld

I objc[3464]: Class JavaLaunchHelper is implemented in both /Library/J
—;  Second: HelloWorld

n =

i

# | &

B0 |

x

~

24. First attempt to run the unit test by right-clicking on the file and selecting Run. This will fail as the javaagent flag has not been set up.



v [Ctest e
v [java
¥ [Fledu.rice.comp322
& Labl—
» Eliarget New >
€ .gitignore M Cut 3oy
M pom.xm| Copy Path o%C
=/ README Copy Reference N{OC
» [} External Libraries [l Paste 3p/
E» Jump to Source F4
Find Usages XF7
Analyze >
Refactor >
Clean Python Compiled Files
Add to Favorites >
Browse Type Hierarchy “H
Reformat Code... L
Optimize Imports... O
Delete... =
Make Module 'labl’
Compile 'Lab1Test.java’ {+#F9
@ Create 'Lab1Test'...
Run 'Lab1Test'
#¥ Debug 'Lab1Test' ~{+F9
¥ Run 'Lab1Test' with Coverage
Run [ HelloWorldError Local History >
b 4 /Library/Java/ay Subversion >
First: HelloWorl¢ &) Synchronize 'LablTest.java'
Wb objc[3464]: Class e \ /1
jI = Second: HelloWor] Reveal in Finder
L2
E Compare File with Editor
# | & & Create Gist...
o | 1 4 Add to .gitignore file
=

25. Prepare to edit the configurations for the unit test.



2z2

[liabitest~ | > ¥ BB 'F 'E P & |

&l Save 'Labl1Test' Configuration
HelloWorldError

LablTest

[

26. Like in Step 20, ensure that the javaagent flag has been correct passed as a VM option to run the Unit test.

L
806

Run/Debug C
+ -HH%¥- @b l2 Name: |Lab1Test (] Share [ Single instance only
v EApplication
HelloworldError (ST Code Coverage | Logs
v @it E— S
Lab1Test e i Glass : Fork mode: | none &
9
» ¥ Defaults Class: edu.rice.comp322.LabITest =]
M options: -ea -javaagent:/U: imam . i ice/hjlib-cooperative/0.1.4-SNAPSHOT/ hilib-cooperative-0.1.4-SNAPSHOT jar | [=]
Working directory: [Users, i jects /lab_L ][]
Environment variables: [

Use classpath of mod... | [alabl

[] Use alternative JRE:

~ Before launch: Make
L Make

+ [ —[#]a]~

(] Show this page

o

C

ol | (A

27. Note the red bar displaying that the Unit test has failed. After you successfully complete the second part of the lab by correctly parallelizing the

reciprocal sum, this unit test should pass and you should see a green bar.
142:at

AswnclfY > 1

Run  LablTest

> EE =+ % Done:1of 1 Failed: 1(in 155)
» v @ LablTest (edu.rice.comp322) 4 Running iteration 1 of 10
B Running iteration 2 of 10
¥ Running iteration 3 of 10
Running iteration 4 of 10
Running iteration 5 of 10
Running iteration & of 10
Running iteration 7 of 10
Running iteration 8 of 10
Running iteration 9 of 10
Running iteration 10 of 10
segArraySum completed in 692.334 milliseconds, with sum = 19.991530
parArraySum completed in 690.207 milliseconds, with sum = 19.991530

ANNNARRRANNAARRANNNARREANNANRRAN

L-gon |
B ch @ 5

~ X % 2

java.lang.AssertionError: Speedup must be at least 1.5, actual 0.9959783201586161 <2 internal calls>
at edu.rice.comp3zz. LaplTest. testReciprocal Parallelism(LablTest. java:43) <23 internal callss

Process finished with exit code 255

Ask your instructor or TA if you run into any issues.
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